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Glossary
#
.csv: comma separated values (file extension)
.cut: Cabinet Vision cut list (file extension)
.ini: configuration information file for MS Windows applications (file extension)
.rs: record set (file extension)
.tsc: TigerStop cut list (file extension)

A
amplifier: the electronic device that drives TigerStop, located inside the motor box
application: the saw or other equipment used as the primary tool with TigerStop
ASCII: Acronym for the American Standard Code for Information Interchange. Pronounced ask-ee,
ASCII is a code for representing English characters as numbers, with each letter assigned a
number from 0 to 127

B
bug: a malfunction in software

C
Cabinet Vision: a drawing program used by the woodworking industry to generate visual depictions of
the finished product as well as cut list files
calibration: the routine that is run to tell TigerStop its distance from zero, which is the location of the saw
blade or the zero reference point on other equipment
character delimited: data fields, usually divided by commas
character string: a series of characters manipulated as a group
CLD: Cut List on Demand (TigerLink 5.0)
clipboard: software holding area where cut or copied data is placed until you paste it into a file
command line: typed commands that operate a program
control key: two bottom row corner keys of a computer keyboard, marked "Ctrl" used in combination
with other keys to perform special functions
current status: what TigerStop is doing right now
custom link: software application for creating job files, other than 'off the shelf' commercially available
cut listing programs
Customer Service contacts: (360) 254-0661 x238 Mon-Fri 7am~4pm PST (West Coast),
service@tigerstop.com
vii
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cut list: a list of lengths (or positions) and number of cuts per length (or cycles per position) stored in
TigerStop memory, either entered manually at the controller, or downloaded from a computer
cut listing software: software which generates cut lists from data in CAD or other design programs

D
data entry style: measurement systems in which cut list data is entered
decimal format: fractions expressed in tenths, hundredths, thousandths, etc., after a decimal point
decrement: subtracting from piece count (number of cuts per length) one at a time
Defect: undesirable material, included in Stock Length, but not in Clear Length
descriptors: the first 8 characters of the first 2 description fields under Print Order in TigerLink’s Data
Manager
destination tab: tab in the Scheduler application window where released work orders can be viewed
dialog box: an interface between software and user, in which the user is asked to make a selection or type
the data in a field
download: copy data (usually an entire file) from a main source to a peripheral device
drive end: alternate (older) term for "motor end"
drive letter: a letter designating a drive on your computer

E
End Trim: material removed from the leading or trailing end of the Stock Length
English: measuring system based on inches (12 inches = 1 foot)
ethernet: a frame-based computer networking technology for local area networks (LANs)
event: an action or occurrence detected by a program such as user actions (clicking a mouse button or
pressing a key), or system occurrences (running out of memory, etc.)
Excel: MicroSoft spreadsheet program, often used to generate cut lists

F
factory password: an unchangeable password used to access restricted menus or functions
far end: the end of the TigerStop fence farthest away from the motor box, opposite of motor end, a
physical designation of the TigerStop
field: a space allocated for a particular item of information; a collection of fields is called a record
filter: a pattern through which data is passed, only data that matches the pattern is allowed to pass
through the filter
FSNS: Factory Settings Not Saved, an error message received on controllers

G
global: a parameter affecting all relevant TigerStop functions or operations, opposite of local
viii
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global head and tail cuts: front and back End Trims, set by parameters in the Operation menu, and
applicable to ALL cut lists
GUI: graphical user interface

H
head cut: material removed from the leading end of a board, not included in Clear Length, to square up
the board for the first Piece (finished part) and remove potential end Defects (splits)
HKEY_Local_Machine: settings for hardware, operating system, and installed applications
home end: the end of the TigerStop fence farthest away from the saw or application machine, opposite of
zero end, a functional designation of the TigerStop
home routine: the start-up routine completed by all TigerStops, a five stage process that confirms
TigerStop parameters at every power ON
hot keys: another name for the GoSet function, which stores programmable lengths behind key
combinations 1 to 99

I
I/O: input/output
idle end: alternate (older) term for "far end"
inbound movement: a movement of the stop towards the zero point (the saw or other equipment)
increment: a TigerStop push feed mode in which a single length is pushed over and over again
integer format: whole number
ips: inches per second

J
job file: raw data generated by cutlisting or other software that TigerLink will transform into a work order

K
kerf: the width of the cut made by a saw blade, relating to width of the carbides or teeth
key field: a field that you use to sort data, also called a sort key, index, or key word
keyboard short cut: controller key combinations held down together to access menus or operations

L
language file: a text file loadable into the controller that contains most of the display texts, available for
English, Spanish, French, German and Dutch
leading end: the end of the material that enters the saw first, the front end of a board
level: group of available options loaded into TigerStop

ix
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local: a parameter affecting only the specific TigerStop function or operation to which it is applied,
opposite of global
local head and tail cuts: front and back End trims, set for the current cut list ONLY

M
M5 menu: the kerf parameter menu
material: set defined as same wood species, width and thickness, used to group parts for processing
menu: a list of available options, parameters or operations, accessed at the controller
metric units: millimeters, as displayed at the TigerStop controller
min/max limits: the close and far limits of TigerStop travel
mode: method of operation
motor end: the end of the TigerStop fence closest to the motor box, opposite of far end, a physical
designation of the TigerStop
move: the simplest TigerStop function, enter a position, press START, and the stop moves to the position
entered

N
non-warranty: no longer covered by TigerStop warranty

O
offset: distance or displacement
operating range: the range of movement of a TigerStop
operational length: the range of movement of a TigerStop
optimize: get the most out of your material in the least amount of time
optimized cut list: set point or push feed cut list which is run in optimize mode, which divides each
available Clear Length into finished parts with the least amount of Waste

P
parallel port: an interface from a computer system where data is transferred in or out in parallel, that is,
on more than one wire (contrast serial port)
parameter: value found in a TigerStop menu which controls the movement, operation or functioning of
the machine
pattern mode: TigerStop cut list method where consistent stock lengths are push fed through a saw to
produce repeating sets of finished parts
PC: personal computer
PET: Precision End Trim, parameter in the operation menu, used only in precision end trim optimizing,
controls the distance the stop must move to cut out a split in the end of a board
x
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Piece: finished part in a cut list, cut out of the Clear Length
piece count: the number of Pieces needed at a given length
PLC: programmable logic control
populate: automatically fill in a field with data
port: an entrance to or exit from a data network, or a connection point for a peripheral device.
position error: in TigerStop scaling, the difference between the long position and the long measure
values
PP: Permanent Pending
PR: Permanent Released
Product manager: the original name for TigerLink 5
program: enter lengths (or positions) and number of cuts per length (or cycles per position) into
TigerStop memory (either manually at the controller, or by means of data download) to create a
cut list
PT: Permanent
push feed mode: TigerStop cut list method where material is push fed by the TigerStop into the saw and
the finished parts come out on the outbound side of the saw blade
pusher: the yellow flip-away stop when used in push feed mode

R
ramps: rate of acceleration and deceleration
RD: Released
read only: a data field that can only be viewed but not edited
reboot: to restart your computer
registry: a database used by the Windows operating system to store configuration information
right click menu: using a mouse to select data, right clicking the mouse will open a menu of options
available for the selection
root directory: the directory that includes all other directories, simply represented by /

S
Salvage: part from the Clear Length that was unusable by the optimizer (possibly included in Waste), but
potentially usable in a new cut list
scale: the number of encoder pulses equal to 1/1000 inch of movement, also, a measurement between two
points, generally a long and short measurement on a TigerStop
scale a TigerStop: perform a scaling adjustment on a TigerStop
scale factor: the value of the scale parameter found in the motion menu
serial port: an interface on a computer system with which information is transferred in or out one bit at a
time (contrast parallel port)
xi
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set list: the list of cuts the optimizer plans to take out of a Clear Length
set point mode: TigerStop cut list method where material is manually fed into the saw toward the
TigerStop and the finished parts come out between the flip-away stop and the saw blade
software level: Level 1 (Basic), Level 2 (TigerSet), Level 3 (Optimizer), Level 4 (Label printing)
software set: a group of programs that work together to achieve the desired objective
Solution: a preliminary list of Pieces to be cut from a Clear Length
spreadsheet: a set of data arranged in rows and columns, in which some cells contain raw data (numbers
or words) and others formulas (representing calculations, such as the total of a range of numbers)
SRS: software requirements specification
Start Menu: the green "start" button in the lower left corner of your Windows XP desktop
Stock Length: the total length of material to be processed
stop: the yellow flip-away stop attached to the TigerStop carriage
string: a contiguous sequence of symbols or values [For example, in TigerLink a maximum of 255 strings
can be transmitted.]

T
tail cut: material removed from the trailing end of a board, not included in Clear Length, to square up the
last Piece (finished part) and remove potential end Defects (splits)
target: the position TigerStop is moving to
TL5: short for any version of TigerLink 5.0
tool: any material processing machine that is used with TigerStop
tool tips: pop-up explanations of what a button or other tool does, appearing when you pass the cursor
over the tool
toolbar: also called a button bar, a tool bar is a row of icons that operate like buttons within a program.
trailing end: the end of the material that exits the saw last, the back end of a board

U
UI: user interface
upcut saw: a circular saw concealed inside the tool except when it jumps up to make a cut
upload: transmit data from a computer to a bulletin board service, mainframe, or network
UR: Unreleased
user interface: the junction between a user and a computer program, a set of commands or menus
through which a user communicates with a program

V
velocity: the constant speed at which TigerStop travels from point to point
version: release number of software loaded into TigerStop
xii
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virtual:

W
Waste: material the optimizer was unable to use, including kerf, from the Clear Length, some of which
can become Salvage
work order: a list of cut lengths or positions sent to TigerStop for processing, contrasted with job file
work order program: another name for cut listing software
working length: the length of TigerStop travel between its minimum and maximum limits, the range of
movement which names the TigerStop [For example, TigerStop10 has a range of movement of 10
feet between its minimum and maximum limits.]

Z
zero end: the end of the TigerStop fence closest to the saw or application machine, opposite of home end,
a functional designation of the TigerStop
zero point: the precise location of the saw blade or the zero reference point on other equipment used with
TigerStop
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Getting Started

Introducing TigerLink 5.2
TigerStop is pleased to introduce TigerLink 5.2.
TigerLink 5.2 is the essential tool for sending work orders to all the TigerStops in your shop. Its intuitive
interface, familiar work environment and versatility make it the standard for any manufacturer that desires
maximum efficiency and increased productivity.
In short, TigerLink 5.2 is the software solution that makes your business more profitable.

Key Benefits
TigerLink is easy to install, easy to set up, and easy to use.
 When TigerLink is first installed on your PC it will automatically search for the most popular
cabinet and cut listing software programs in the market today. Once a program is detected, any
new job file that is opened in TigerLink will automatically be sorted, based on that program's
defaults.
 TigerLink lets you modify and even create work orders within the program.
 After the work order is completed and ready to be processed, the Scheduler is used to manage
work flow, allowing each work order to be scheduled for production and sent to multiple saws,
areas or plant stations simultaneously.
 Once the work order has been scheduled for processing, it can be accessed at the TigerStop
controller.

1
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With a continuous connection between TigerStop and the local PC, there is practically no limit to
the number of work orders that can be processed and sent to TigerStop.
See also: System Requirements, File Requirements.

New Features: TigerLink 5.2 …

Compared to TigerLink 3.2






TigerLink 5.2 is a major upgrade from TigerLink 3.2.
TL5 was re-written from the ground up with a new interface that includes an integrated label
designer for label printing purposes.
With TL5 you only have to create a “link” to TigerStop once, not over and over again as in the
previous 3.2 version.
Cut list values can be directly edited within TL5 as well as configured to communicate with one or
more TigerStops.
Along with TigerLink, the product package includes a program called Scheduler. With Scheduler
you can set work order priorities, decide which work orders go to which TigerStop, monitor the
progress of a work order, and much more.

Compared to TigerLink 5.1








The "Optimize" check box was moved from the top of the main screen to the "Options/TigerLink
configuration" drop down. At the TigerStop tab, the [Edit] button opens a dialog that hosts the
"Optimize" check box. This works the same way as in TigerLink 5.1.
The option "Change name" has been removed from the "Work Order" drop-down menu in the
TigerLink main window.
The File configuration screen "select the job column" has been modified.
The "Report" function found in the "View" drop-down menu in TigerLink 5.1 has been moved.
This exporting feature of TigerLink which lets you dump server information into a .csv file is now
located in Scheduler, in the "File" drop-down menu.
Significant layout changes occurred in the "TigerLink configuration" dialog screen accessed from
the main window at the "Options" drop-down menu. The original 7 tab structure was reduced to 5
tabs. There were no changes to four tabs: TigerStop, TigerServer, Language and Filters. A new
fifth tab, Settings, was introduced for some of the functions in the three tabs that were eliminated.
The grid below is a guide to the changes.
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TigerLink 5.1

TigerLink 5.2
The "Cutlist program" tab was eliminated.
These functions moved to the Settings tab:
"Work order program" drop-down combo box
"Use job number from file" check box
"Metric check box
"Source directory" box with […] browser was
eliminated. (This showed location of job files.)

Cutlist program tab

Language tab

Language tab

TigerServer tab

TigerServer tab
3
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The "Printing" tab was eliminated.
These functions moved to the "Item/Part sorted by
PART" window.
"Printing is off" drop-down combo box changed to
"Enable printing" checkbox.
"Label file to print" box with […] browser changed to
"Label file" box with […] browser.
Functionality is the same.

Printing tab

TigerStop tab

TigerStop tab
The "Misc" tab was eliminated.
These functions moved to the Settings tab:
"Show the splash screen" checkbox
"Show tooltips" checkbox
"Show upload dialog" checkbox
Functionality is the same.

Misc tab

Filters tab

Filters tab
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Overview of TigerLink 5.2
TigerLink 5.2 modules and how they work
TigerLink is one module of a software set designed to get your
job files from the PC to the TigerStop controller as easily and
quickly as possible. Briefly, these are the other modules:
TigerServer is a Windows service routine that is always running
in the background of your PC. TigerLink sends your working
data to TigerServer which stores it, so it can later be made
available at the TigerStop controller.
Scheduler is used to manipulate the working data stored in
TigerServer. At the TigerStop controller, the machine operator
can view all of the working data stored in TigerServer.
Within the Scheduler program, the user can release work orders
to one or more TigerStops, delete work orders, change the
priority of work orders, etc.
The Scheduler can also provide work order status feedback from
a given TigerStop.
Fig. 1
TigerLink takes the data generated by the user's cut list program, Cabinet Vision, Cabnetware, etc., and
transforms it into something that the controller can understand. While the data is in TigerLink, the user is
able to edit it. The user then sends that data to the controller. In reality, however, the data is really sent to
TigerServer, even though it is visible from the controller.
It is important to know that the controller does not actually contain any cut list information yet.
The work orders that are sent to TigerServer are initially set to UNRELEASED status. Work
orders must be set to RELEASED status before TigerStop can view or download them.
Once work orders have been set to RELEASED status, the machine operator can view a list of available
work orders at the controller by pressing [PRGM]>[PRGM]. This lets the machine operator scroll through
a list of all available work orders in order of the priority each work order was set to. Priority 1 work
orders will be viewed first. With a work order selected, pressing [START]>[START] will cause the
controller to download that work order from TigerServer. The machine operator can then run the work
order as usual. Keeping work orders stored in TigerServer allows the user to have virtually unlimited
numbers of work orders rather than be limited by controller memory, as in the past. Once the first work
order has been processed, the machine operator is ready to process the next available work order.

System Requirements
1. To use TigerLink the following is necessary:
1. An IBM PC or compatible, running Microsoft Windows XP Professional. See 2 below for
what is needed to run Windows XP Professional.
2. The TigerStop must be enabled with Level 3 software.
3. Currently, an available Com Port is required with a 232 serial interface. Future releases will
allow for alternative connections.
5
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4. Connect to the controller using a DB9 serial cable. See Fig. 1 below for the cable pin out.
5. A serial extender may be required if the distance between the computer and the TigerStop is
greater than 50 feet. For more information on the serial extender, see the Serial Extender
product guide in the TigerStop Manual 4.6.
2. Here's what is needed to run Windows XP Professional:
1. PC with 300 MHz (megahertz) or higher processor clock speed recommended; 233 MHz
minimum required (single or dual processor system); Intel Pentium/Celeron family, or AMD
K6/Athlon/Duron family, or compatible processor recommended
2. 128 megabytes (MB) of RAM or higher recommended (64 MB minimum supported; may limit
performance and some features)
3. 1.5 gigabytes (GB) of available hard disk space
4. Super VGA (800 × 600) or higher-resolution video adapter and monitor
5. CD-ROM or DVD drive
6. Keyboard and Microsoft Mouse or compatible pointing device

Serial Cable Pin-Out

Fig. 1

TigerLink File Requirements
TigerLink file requirements are as follows:
 The file type must be an ASCII text file.
 The file must be character delimited. We recommend using the comma as the delimiter.
 The length value must be in decimal format (example: 123.456).
 The quantity field must in integer format. If a quantity field is not specified, TigerLink will
assume a quantity of 1 per line.
 All the data for one cut must be in one row (example: material, 123.456, 1)
 There must be a carriage return at the end of every line of data.
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Installing TigerLink
Concept
TigerLink is installed the same way you install any other
Windows application.
You will insert the installation CD into your computer's CDROM drive. If auto-play is enabled, the installation will
automatically start. If auto-play is not enabled, you must run
the setup manually. The following instructions will step you
through the installation process.

Installation
The TigerLink installation program, SETUP.EXE, is a Windows program. It is located in the root
directory of the TigerLink CD.
Windows XP Professional must be loaded as the operating system before TigerLink can be
installed. Before installing, see also System Requirements.
1. Power up your computer and let it go through its routines. When your Windows desktop appears,
you are ready to install TigerLink.
2. Insert the TigerLink CD into the CD-ROM drive. When the CD is inserted into the CD-ROM with
Windows XP Professional running, the program should start automatically and run through the
installation steps. If it does not, try re-inserting the CD, or continue at step 3.
3. From the Start Menu, select "Run…"
4. In the Run dialog box (Fig. 1), type: D:/SETUP. If your CD drive is not designated by D, change
the drive letter in the command line above, substituting the drive letter you are using.

Fig. 1
5. When you have typed the appropriate command line, click [OK]. After the files are copied from
the CD to your computer, SETUP searches the computer hard drive for signs of known cut listing
programs. If one is found, SETUP will ask if you want that program to be set as the default, and
program will apply it accordingly.
6. SETUP does not automatically install TigerServer. You will be asked if you would like it installed.
At the dialog box (Fig. 2), click [Yes] to install TigerServer.
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Fig. 2
7. Installation is concluded. The reboot dialog box appears (Fig. 3). You should click [Yes], unless
you have a good reason to delay the reboot. For example, you should not have any other programs
open and running when you reboot your computer. Then click [Finish] to complete the process and
restart your computer. You MUST restart your PC to complete the installation of TigerServer and
to allow TigerLink to function properly.

Fig. 3

Installation Troubleshooting
This topic provides information on common problems and their solutions. Please read this topic before
contacting Installation Support.

Program will not run
Confirm the computer meets the minimum system requirements. See System Requirements.

Program runs but has errors
If you are unable to view TigerLink or are experiencing other program errors, follow this procedure:
8
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1. Uninstall TigerLink. See Uninstalling TigerLink.
2. Re-Install. See Installing TigerLink.

For More Information
http://www.tigerstop.com/tech.html provides help with installation or other issues you may have and
includes all the latest downloads to your software.

Uninstalling TigerLink
These procedures are effective only if TigerLink is installed using the TigerLink Setup program.

To uninstall TigerLink from the Windows XP Professional desktop environments:
1.
2.
3.
4.

Click the green [Start] button in the lower left corner of your Windows XP Professional desktop.
Select Settings > Control Panel.
Double-click Add/Remove Programs.
Click Install/Uninstall. Then select TigerLink from the list of programs that can be automatically
removed.
5. Click the [Remove...] button to uninstall TigerLink.
If TigerLink does not show in the list or if the automatic uninstall fails, uninstall TigerLink manually.
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Starting and Running TigerLink
Quick Start
The TigerLink desktop icon
To start TigerLink 5.2, double click the TigerLink icon found on your desktop, or locate it in
the TigerLink subgroup in the Start Menu, under Programs. If it is there, select the icon, hold
down the LEFT mouse button, and drag the icon out on to your desktop. The result of this
action will be to create a shortcut of TigerLink on your desktop.

The TigerLink splash screen
When TigerLink first starts up, a splash screen is displayed that contains various options (Fig. 1).

Fig. 1
The options shown in the splash screen are as follows:
1. Continue — This opens TigerLink.
2. www.tigerstop.com — This links to the TigerStop corporate web site.
3. Exit — This closes TigerLink without using it.
4. Scheduler — This opens Scheduler.
5. Help — This opens the TigerLink 5.2 User Manual.

Open the main TigerLink window the first time
Click [Continue] to open the main application window (Fig. 2).

11
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Fig. 2
The pop up advises:
"TigerLink is currently set to use the default profile. The default profile is a very simple profile that will
allow you to start working with TigerLink now. You also have the option of configuring your own set of
rules to make TigerLink read your job files. To use the default profile, you can simply enter the
information into the grid as if it were a Microsoft Excel spreadsheet. Or, you can use Microsoft Excel to
build your work orders. See the default.csv file in the TigerLink Example files folder for an example."

Select a profile
You select a profile by clicking one of the three buttons at the bottom of the pop up.
 Click "Use default" to use the default profile.
 Click "Select other" to select an alternate work order profile.
 Click "Decide later" to continue on without making any changes.

Open the main TigerLink window
Click [Continue] to open the main application window (Fig. 2a). The empty bottom half of the screen has
been cut off to save space.
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Fig. 2a

Configure TigerLink
First thing to do is configure the application to your work environment. Along the top of the main
application window is a row of drop-down menus (Fig. 2b). Below the drop-down menus is a toolbar (Fig.
2c).
Fig. 2b

Fig. 2c

Click "Options" to open the drop-down (Fig. 3). Click "TigerLink configuration."

Fig. 3

Select your default cut listing software
The Configuration dialog box will open (Fig. 4). There are five tabs across the top to organize the
configuration of TigerLink functions. The "Settings" tab is where you select the cut listing software you
want to use as your default, from the drop-down combo box labeled "Work order program."
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Fig. 4
If your software is not listed, or if you use Microsoft Excel to generate your cut lists, you will have to
configure TigerLink to interpret your files manually. For this example, we are selecting Cabinet Vision as
our default cut listing software (Fig. 5).

Fig. 5

Add the TigerStops you will be communicating with
The next thing that TigerLink needs to know is the TigerStops that you will be communicating with. The
"TigerStop" tab is where you set this up. Select the "TigerStop" tab. On a first install, the screen should be
blank, no TigerStops configured. Click [Add] from the buttons to the right of the screen (Fig. 6).
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Fig. 6
The "Add TigerStop" dialog box will open (Fig. 7).
1. From the "Comport" drop-down combo box, select the Comport that the TigerStop is hooked up to.
2. In the "Name" text box, give the TigerStop an appropriate name such as "Frame saw".
3. From the "Baud rate" drop-down combo box, select the baud rate that EXACTLY matches the
baud rate setup for that TigerStop. The baud rates MUST match exactly.
4. From the "Machine type" drop-down combo box, select either push feed or set point. (Pattern
would be considered "push feed".) If the TigerStop will be processing optimized work orders,
check the "Optimize" box. Click OK to close the dialog box and save your set up.

Fig. 7

Open a job file
There are four function buttons on the left side of the main screen (Fig. 8a).
Click [Grab job] to open up a job file and to select the parts you want to process.
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Fig. 8a
Clicking [Grab job] opens the "Grab job" screen (Fig. 8b).

Fig. 8b
Select the job file you want by clicking on it. Its name will appear in the "File name" drop down. Click
[Open] to accept the file.

Select the parts you want to process
The "Item/Part sorted by PART" dialog box opens (Fig. 9). Notice that the dialog has created a tab for us.
The tabs let you group parts that logically belong together.
Select ALL the parts in the part list by clicking [>>]. See Fig. 11 for the result.
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Fig. 9

Rename the tab containing your job file data
Click the "Options" drop-down, and click "Tab" to access tab related actions (Fig. 10a).

Fig. 10a
Click [Rename tab] to give the tab a more appropriate title. Another dialog box opens (Fig. 10b). Here we
are simply renaming the tab to Frames to indicate that these parts belong to our frames group. Click [OK].
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Fig. 10b

Select a destination TigerStop for your work order
Now we have a Frames tab (Fig. 11). You can select a destination TigerStop in this window if desired.
Selecting the destination here will assign the same destination to ALL the work orders at this tab.

Fig. 11
Each tab can be assigned to separate destinations. The destination TigerStop can be changed for each
work order individually in other areas of the program. Let's assign our destination TigerStop now.
The drop-down combo box (Fig. 12) will list all TigerStops defined for this system. If you have only one
TigerStop, or if only one has been defined, there will only be one destination in the drop-down.
Click on the TigerStop named "Chop Saw" to select it as the destination.
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Fig. 12
Click [OK] to accept your selection. This tab will be saved and displayed every time you open this dialog
box. TigerLink takes the information from the previous step and extracts the parts from your work order.

View your work order in the main application window
The main application window now displays the parts in spreadsheet fashion (Fig. 13).

Fig. 13
Just as in any spreadsheet, the headers are labeled to show you properties of the work order, and the cells
of the spreadsheet display the parts grouped by the same width, thickness and species. The light blue cells
are key fields that cannot be changed at this screen. You can, however, edit the values in the white cells of
the work order here.

Send your work order to TigerServer
Click [Send] since we do not want to edit anything (Fig. 14).
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Fig. 14

Verifying the work orders to send to TigerServer
The "Verify work orders to upload" dialog box opens (Fig. 15), to let you have another chance to send
work orders. You can uncheck work orders that are not quite ready to go to the TigerServer.
If you want to bypass this dialog box in the future, uncheck "Show dialog."
Work orders with an INACTIVE status are NOT sent to TigerServer.

Fig. 15
When you have made your selections, click [OK] and TigerLink will send the work orders to TigerServer,
and start the Scheduler.

The Scheduler application window
The Scheduler application window opens (Fig. 16). The status of all work orders is set to UNRELEASED,
as shown in the farthest column on the right as "UR." The default application window is actually on the
"Unreleased" tab (Fig. 19).
The status of any work order can be changed by using the drop-down combo box in the status column.
The status of a group can also be changed be selecting multiple work orders and using a right click menu,
which is explained in detail below.

Fig. 16
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Selecting multiple work orders
Left click and drag the mouse to select two or more work orders (Fig. 17).

Fig. 17

Changing the status of multiple work orders
After selecting multiple work orders, right click the mouse, and the right click menu will appear (Fig. 18).
The three options beginning "Set to…" refer to status. Click the desired status. All work orders selected
will be set to the same status, and the dialog will close.

Fig. 18

Destination tabs
At the bottom of the Scheduler application window are tabs corresponding to the TigerStops defined for
this system. These are destination tabs (Fig. 19). When the status of work orders is changed to
RELEASED, they are moved to their destination tabs. Unreleased work orders are at the "Unreleased" tab,
which is what you see when the Scheduler application window first opens.

Fig. 19
Once work orders have been released, they are visible at the controller.

TigerLink Interface
Working with the Toolbar
Toolbars are a great shortcut to commonly used features. To invoke the action of the toolbar buttons, click
with the left mouse button on the tool you need.
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If you are not sure which tool you need, place the mouse pointer on top of a button without clicking and a
tool tip will remind you what the button does.
Fig. 1

Working with the drop-down Menus
To choose a menu item, just click on it with the mouse, OR hold down the ALT key and press the
underscored character of the menu item. For example, ALT-F opens the File menu.
To view all the drop-down menus in rapid succession, just click on anyone of them, and then glide the
cursor across the others. As the cursor moves over a menu item, the drop-down will automatically display.
Fig. 2
Continue to Drop-Down Menus, File.

Working with the grid context Menu
If the grid is populated, the user can access a drop-down context menu by right
clicking the mouse with any cell selected on the grid area. Changes made using a
context menu function will affect and be referenced to the cell selected.
Continue to the Grid Context Menu …
Fig. 3

What is a work order?
A work order is the file that contains the list of parts to be processed.
Files from cut listing software (job files) are converted into the work orders seen in TigerLink.
See also: File Requirements
A work order can also be manually created in TigerLink.
The work order is displayed inside the work space after it has been sorted through the Part Select process.
The work order contains individual tabs for similar parts. Each tab has independent properties and can be
edited or deleted individually.
In the TigerLink main window parts are displayed in rows (lines) with column headers. These headers are
obtained from the original file with the headers of sort columns highlighted. Sort columns cannot be
edited or updated. All other information can be modified.

Drop-Down Menus
File
Select a function in the File drop-down menu by holding the cursor over it and clicking. You can also
select some of the functions with keyboard shortcuts.
If a function is grayed out, it is not available for items in your active window.
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Grab job - Allows the user to open a job file.
New work order - Creates a new blank work order.
Open work order - Opens a previously saved work order.
Save work order - Saves the current work order to a file for later retrieval.
Exit - Exits the application.

Edit
Select a function in the Edit drop-down menu by holding the cursor over it and clicking. You can also
select some of the functions with keyboard shortcuts.
If a function is grayed out, it is not available for items in your active window.





Cut – Cuts whatever is selected to the clipboard.
Copy – Copies the selected to the clipboard.
Paste – Pastes the contents of the clipboard.

View
The View drop-down menu lets the user show or hide the toolbar and the status bar. A check mark placed
in the box makes the item show. Unchecking the item hides it.




Toolbar – Shows or hides the toolbar.
Status bar – Shows or hides the status bar.

Work order
Select a function in the Work order drop-down menu by holding the cursor over it and clicking. The Sort
function is toggled on or off using a check mark box..
If a function is grayed out, it is not available for items in your active window.
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Print – Prints the currently displayed work order.
Print preview – Shows the user a preview of what the print would look like.
Delete work order – Deletes the current work order.
Write comment – Writes a comment to be saved with the current work order.
Sort – Enables or disables the work space sorting functions.
Change number – Allows the user to change the work order number.
Change key value – Allows the user to change the value of a key field.

Send
Select a function in the Send drop-down menu by holding the cursor over it and clicking. You can also
select some of the functions with keyboard shortcuts.
If a function is grayed out, it is not available for items in your active window.




Send – Sends the active work orders to TigerServer.
Language – Allows the user to send a language file to the controller.

Add
Select a function in the "Add" drop-down menu by holding the cursor over it and clicking.




Add row – Adds a blank row to the work order.
Add column – Adds a blank column to the work order.

Label
Select a function in the Label drop-down menu by holding the cursor over it and clicking.



Design a label – Opens the integrated label designer window.
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Options
Select a function in the Options drop-down menu by holding the cursor over it and clicking. You can also
select some of the functions with keyboard shortcuts.
If a function is grayed out, it is not available for items in your active window.

TigerLink configuration – Allows the user to configure various options for the application
Move the cursor over "Advanced" to view an additional drop-down with these functions, which are
selected by clicking on them.






Configure view – Allows the user to configure the work space view.
File configuration – Allows the user to configure TigerLink to read their job files.
Edit profile – Allows the user to edit the profile created in the File configuration process.

Help
Select a function in the Help drop-down menu by holding the cursor over it and clicking.







Help topics – Opens the help file.
TigerLink web site – Opens the TigerStop web site.
Visit TigerTamer – Opens the TigerTamer web site.
Tutorials – Opens the TigerLink tutorials.
About TigerLink – About TigerLink.
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Submit feature request – Submit a feature request to the programmers.
Submit bug report – Submit a bug to the programmers.

Grid context menu
If the grid is populated, the user can access a drop-down context menu by right clicking the mouse with
any cell selected on the grid area. Changes made using a context menu function will affect and be
referenced to the cell selected.











Cut – Cuts the selection and places the data on the clipboard.
Copy – Copies the selected data.
Paste – Pastes the data from the clipboard to the selection.
Delete row – Deletes the currently selected row or rows.
Add row – Adds a new row to the work order.
Add column – Adds a new column to the work order.
Delete column – Deletes the selected column.
Change key value – Allows the user to change a key value for this work order. Only enabled when
the user has selected a cell in the key value column.
Delete work order – Deletes the work order.
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Scheduler
Introduction
Scheduler is the software component of TigerLink 5.1 that lets the user manipulate work orders after they
have been sent to TigerServer.
Scheduler also acts as a work flow monitor. If a particular department is backed up, the user can reroute
work orders to another TigerStop for processing. That way work keeps flowing through production.
Scheduler can also query TigerServer and update the status of work orders in the system.

Starting Scheduler
Start Scheduler from the TigerLink splash screen
Scheduler can be started from the TigerLink splash screen (Fig.1) by clicking "Scheduler."

Fig. 1

Start Scheduler from the Scheduler desktop icon
It's probably faster and easier to start scheduler from its desktop icon.
Step through Scheduler by starting at the Scheduler Main Window in the Screen Shot Library.
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Scheduler Interface
Working with the Toolbar
Toolbars are a great shortcut to commonly used features. To invoke the action of the toolbar buttons, click
with the left mouse button on the tool you need.
If you are not sure which tool you need, place the mouse pointer on top of a button without clicking and a
tool tip will remind you what the button does.

Fig. 1

Working with the drop-down Menus
To choose a menu item, just click on it with the mouse, OR hold down the ALT key and press the
underscored character of the menu item. For example, ALT-F opens the File menu.
To view all the drop-down menus in rapid succession, just click on anyone of them, and then glide the
cursor across the others. As the cursor moves over a menu item, the drop-down will automatically display.

Fig. 2

Drop-Down Menus
File







Print - Click on Print to send the file to a printer.
Export - Click on Export and select a list to send a report of your data to a file. If the file does not
exist yet, it is created. If it already exists, it appends the information to the end of the file.
Export/Unreleased - This option exports ALL of the unreleased jobs.
Export/(Name of TigerStop) - This option exports only COMPLETED jobs.
Exit - Click on Exit to close the application.

Edit
Select a function in the Edit drop-down menu by holding the cursor over it and clicking. You can also
select some of the functions with keyboard shortcuts.
If a function is grayed out, it is not available for items in your active window.
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Cut – Cuts the selection and places the data on the clipboard.
Copy – Copies the selected to the clipboard.
Paste – Pastes the contents of the clipboard.
Delete row – Deletes the selected work order.
Delete all work orders – Deletes all the work orders on the current tab.
Set release status – Sets the selected work order to RELEASED status.
Set permanent status – Sets the selected work order to PERMANENT status.
Set permanent released status – Sets the selected work order to PERMANENT RELEASED status.

View
The View drop-down menu lets the user show or hide the toolbar and the status bar. A check mark placed
in the box makes the item show. Unchecking the item hides it.






Toolbar – Shows or hides the toolbar.
Status bar – Shows or hides the status bar.
Command Window – Allows the user to send commands directly to TigerStop.
Refresh – Refreshes the displayed data.

Tools
The Tools drop-down menu lets you configure the program in various ways.



Configuration – Opens the configuration dialog.

Help
Select a function in the Help drop-down menu by holding the cursor over it and clicking.
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About Scheduler – Displays the "About" dialog.
Submit bug report – Opens a dialog box in which the user can communicate with TigerStop about
bugs found in the program.
Submit feature request – Opens a dialog box in which the user can communicate with TigerStop
about ideas for new features in the product.
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Save a work order?
To save a work order for future use, use the "File" drop-down menu, and select "Save work order" (Fig. 1)
…

Fig. 1
… and your work order will be saved (Fig. 2).

Fig. 2

Load a work order?
To load a previously saved work order into the work space (Fig. 1) …

Fig. 1
… use the "File" drop-down menu, and click "Open work order" (Fig. 2).
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Fig. 2
The "Select a Work Order file" dialog box (Fig. 3) will list all of the work orders saved on the system.

Fig. 3
Select the work order file that was previously saved (Fig. 4), and click [OK].

Fig. 4
Your work order is read in and displayed (Fig. 5).

Fig. 5
Notice that a part group tab, "Doors" was also automatically created.
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Open a job file?
To open a job file, use the "File" drop-down menu, and click "Grab job" (Fig. 1), or click the [Grab job]
button on the navigation bar (Fig. 2).

Fig. 1
Fig. 2
The "Grab job" window will open (Fig. 3).

Fig. 3
In this example, we are working with a Cabinet Vision file. Notice that only Cabinet Vision files (file
extension *.cut) are displayed. Click [Open]. The "Item/Part sorted by PART" window, called the "Part
Select" window in TigerLink 5.1, opens (Fig. 4).
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Fig. 4
The parts from the job file you just opened will be displayed on the left. Parts that you have previously
selected will appear on the right. If you have previously selected a destination TigerStop for these parts,
that will be saved and displayed too. Click [OK] and TigerLink will process the data.

Add a comment to a work order?
To add a comment to a work order, you must first have a work order open in the work space (Fig. 1).
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Fig. 1
There are 3 ways you can add a comment to your work order.
 Use the "Work order" drop-down menu, and click "Write comment" (Fig. 2).
 Click the [Add comment] button in the properties window (Fig. 3).
 Click the "write comment" button on the toolbar (Fig. 4).

Fig. 2
Fig. 3
Fig. 4
When you use one of the above methods to add a comment, the "Write comment" window will open (Fig.
5).
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Fig. 5
Write your comment in the window, and click [OK].

Fig. 6
Your comment will be displayed in the properties window (Fig. 6) for the work order.

Change a work order number?
To change a work order number, you must first have a work order open in the work space (Fig. 1).

Fig. 1
Fig. 2
Click on the Work order drop-down menu, and then on "Change number" (Fig. 2).

Fig. 3

Fig. 4

The "Renumber work order" window opens (Fig. 3).
Check the "Apply to just this work list" box.
Type a new number for the work order in the box (Fig. 4) and click [OK].

36

How do I …?

Fig. 5
The number of the work order has been changed (Fig. 5). Notice, it can be a number or a name.

Change a work order destination?
To change a work order destination, you must first have a work order open in the work space (Fig. 1).

Fig. 1
Click on the Destination drop-down combo box (Fig. 2), and then select a new TigerStop destination from
the list (Fig. 3).

Fig. 2
Fig. 3
The destination for this work order changes to your new selection (Fig. 4).

Fig. 4
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Configure my TigerStop?
At the TigerLink splash screen, click [Continue] to open the main application window (Fig. 1). The empty
bottom half of the screen has been cut off to save space.

Fig. 1
Click "Options" to open the drop-down (Fig. 2). Click "TigerLink configuration."

Fig. 2
The "Configuration" dialog will open (Fig. 3). Select the "TigerStop" tab. On a first install, the screen
should be blank, no TigerStops configured. Click [Add] from the buttons to the right of the screen.
The "Add TigerStop" dialog box will open (Fig. 4).

Fig. 3

Fig. 4
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1. From the "Comport" drop-down combo box (Fig. 5), select the Comport that the TigerStop is
hooked up to.
2. In the "Name" text box, give the TigerStop an appropriate name such as "Frame saw" (Fig.6).
3. From the "Baud rate" drop-down combo box, select the baud rate that EXACTLY matches the
baud rate setup for that TigerStop. The baud rates MUST match exactly. If the controller baud rate
has not been changed from factory default, it will be 115200.
4. From the "Machine type" drop-down combo box (Fig. 7), select either push feed or set point.
(Pattern would be considered "push feed".) If the TigerStop will be processing optimized work
orders, check the "Optimize" box (Fig. 8). Click OK to close the dialog box and save your set up.

Fig. 5

Fig. 6

Fig. 7

Fig. 8

Edit my TigerStop parameters?
At the TigerLink splash screen, click [Continue] to open the main application window (Fig. 1). The empty
bottom half of the screen has been cut off to save space.

39

TigerLink 5.2 User Manual

Fig. 1
Click "Options" to open the drop-down (Fig. 2). Click "TigerLink configuration."

Fig. 2
The "Configuration" dialog will open (Fig. 3). Select the "TigerStop" tab. You will see a list of configured
TigerStops (Fig. 4).

Fig. 3

Fig. 4
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1. Select the line containing the TigerStop you
want to edit (Fig. 5).
2. Click [Edit].
3. The "Edit TigerStop" dialog (Fig. 6) will open,
containing 5 parameters:
1. Comport
2. Name
3. Baud rate
4. Machine type
5. Optimize
4. Edit the parameter(s) you want, and click [OK].
5. Click [Cancel] to exit without saving changes.
Fig. 5
In the example below (Figs. 6-7), the baud rate has been changed from 115200 to 9600.

Fig. 6

Fig. 7

Change TigerLink's language?
At the TigerLink splash screen, click [Continue] to open the main application window (Fig. 1). The empty
bottom half of the screen has been cut off to save space.
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Fig. 1
Click "Options" to open the drop-down (Fig. 2). Click "TigerLink configuration."

Fig. 2
The "Configuration" dialog will open (Fig. 3). Select the "Language" tab. You will see a drop-down
combo box displaying the current language (Fig. 4).

Fig. 3

Fig. 4
1. Click the drop-down to view languages available (Fig. 5).
2. Select a different language (Fig. 6) and click [OK].
3. TigerLink will automatically display, when refreshed, texts in the selected language (Fig. 7,
French).
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Fig. 5

Fig. 6

Fig. 7

Change to metric units?
TigerLink's default measuring system is inches. You can view your cut list data in metric units.
At the TigerLink splash screen, click [Continue] to open the main application window (Fig. 1). The empty
bottom half of the screen has been cut off to save space.
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Fig. 1
Click "Options" to open the drop-down (Fig. 2). Click "TigerLink configuration."

Fig. 2
The "Configuration" dialog will open. Select the "Settings" tab (Fig. 3).
Click the check box labeled "Metric" to change the display to metric units (Fig. 4).

Fig. 3

Fig. 4

The values displayed in the key fields will now be expressed in metric units (Fig. 5).
In the properties window, there will also be a visual indicator that the display is in metric (Fig. 6).
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Fig. 5

Fig. 6

Change to inches?
TigerLink's default measuring system is inches. If you have changed the display to metric units, you can
change it back to inches.
At the TigerLink splash screen, click [Continue] to open the main application window (Fig. 1). The empty
bottom half of the screen has been cut off to save space.

Fig. 1
Click "Options" to open the drop-down (Fig. 2). Click "TigerLink configuration."

Fig. 2
The "Configuration" dialog will open. Select the "Settings" tab (Fig. 3).
Uncheck the check box labeled "Metric" to change the display back to inches (Fig. 4).
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Fig. 3

Fig. 4

The values displayed in the key fields will now be expressed in inches (Fig. 5).
In the properties window, there will also be a visual indicator that the display is in metric (Fig. 6).

Fig. 5

Start or stop TigerServer?
TigerServer can be manually started and stopped.
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Fig. 1

Fig. 2
1. From your Windows desktop, click [Start], select "Settings" and "Control Panel" (Fig. 1).
2. When the Control Panel window opens (Fig. 2), select "Administrative Tools."
3. When the Administrative Tools window opens (Fig. 3), click "Services" to start it, and when the
Services (Local) window opens, scroll down to "PAI TigerServer.

Fig. 3
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4. Select PAI TigerServer. If the service is currently running (Fig. 4), you will have the option of
stopping the service. If the service is not currently running, you will have the option to start the
service.

Fig. 4

Possible communication conflicts
If you are using another peripheral, such as a digital camera, that downloads to the same port as
TigerServer, you must stop TigerServer, to be able to use the other peripheral. TigerServer then must be
restarted. Both actions can be done using the links Stop the service, and Restart the service (Fig. 4).

Make sure TigerServer is running correctly?
TigerServer has a debug mode built into it.
To see the commands that TigerServer is acting on, from your Windows desktop, click [Start], select
"Run" and, when the Run dialog opens (Fig. 1), type “cmd” in the run box, and click [OK].

Fig. 1
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This will start a command shell session similar to a DOS window (Fig. 2). Most of the old DOS command
set is available. Change to the TigerServer directory.
The default installation path is: cd "\Program files\TigerStop\TigerLink\TigerServer”
Your installation path may differ.

Fig. 2
Once you have successfully changed to the TigerServer directory (Fig. 3), start TigerServer in debug
mode, “TigerServer /debug”.

Fig. 3

Fig. 4
If the TigerServer is currently running, the service will be temporarily suspended while the debug is
running.

Fig. 5
Press the [ESC] to exit the program.
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Change my cut list program?
At the TigerLink splash screen, click [Continue] to open the main application window (Fig. 1). The empty
bottom half of the screen has been cut off to save space.

Fig. 1
Click "Options" to open the drop-down (Fig. 2). Click "TigerLink configuration."

Fig. 2
The "Configuration" dialog will open at the "TigerStop" tab (Fig. 3). Click on the "Settings" tab (Fig. 4).
You will see a drop-down combo box labeled "Work order program." This means "cut list program."
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Fig. 3

Fig. 4
1. Click the drop-down to view cut list programs available (Fig. 4).
2. Select a different program (Fig. 5) and click [OK] to save the change.
3. Click [Cancel] to exit without making a change.

Fig. 5

Fig. 6

Change TigerLink's background color
Incidentally, at the settings tab, you can change the background color of the program from the default
orange to any of several colors, such as "triage blue" (Fig. 6). Changing the color here changes it
everywhere.

Make work order and job file number the same?
At the TigerLink splash screen, click [Continue] to open the main application window (Fig. 1). The empty
bottom half of the screen has been cut off to save space.

Fig. 1
Click "Options" to open the drop-down (Fig. 2). Click "TigerLink configuration."
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Fig. 2
The "Configuration" dialog will open at the "Cutlist program" tab. Click on the "Settings" tab (Fig. 3).
You will see a check box labeled "Use job number from file."

Fig. 3
1.
2.
3.
4.

Check the check box to use the job file number as the work order number.
Click [OK] to save the change.
Click [Cancel] to exit without making a change.
If you do not want the job file number to be the same as the work order number, leave the box
unchecked.

Turn label printing on and off?
At the TigerLink splash screen, click [Continue] to open the main application window (Fig. 1). The empty
bottom half of the screen has been cut off to save space.
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Fig. 1
Label printing is turned on or off on a "per cut list" basis at the Part/Item sorted by PART screen (Fig. 2),
which opens whenever you open a job file.

Fig. 2
Check the box "Enable printing" to turn label printing on.
Uncheck the box to turn label printing off.

Print a different label file?
At the TigerLink splash screen, click [Continue] to open the main application window (Fig. 1). The empty
bottom half of the screen has been cut off to save space.
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Fig. 1
Label files are specific to a job file, so to print a different label file, you must open its job file.
To open a job file, use the "File" drop-down menu, and click "Grab job" (Fig. 2a), or click the
[Grab job] button on the navigation bar (Fig. 2b).

Fig. 2a
Fig. 2b
The "Grab job" window will open (Fig. 3).
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Fig. 3
In this example, we are working with a Cabinet Vision file. Notice that only Cabinet Vision files (file
extension *.cut) are displayed. Click [Open]. The "Item/Part sorted by PART" window, called the "Part
Select" window in TigerLink 5.1, opens (Fig. 4).

Fig. 4
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Place a check mark in the "Enable printing" check box, and using the […] browse button, look for the
label file that you want to print. Click [OK] to accept the file, or [Cancel] to exit without saving your
selection.

Get TigerLink to display in an unsupported
language?
If your language is not supported by TigerLink, you can change TigerLink to display whatever language
you want, provided you are willing to translate the terms yourself. Only Roman fonts (not Greek,
Cyrillic or Asian fonts) are supported. Here's how…
1. Open the language files directory, (see Directory Structure), and locate the file named
“English.lng”.
2. Make a copy of this file, and save it. This will ensure that you do not accidentally lose the English
language file.
3. Open English.lng using Window Notepad or any other text editor. Listed in this file are all the
various phrases that must be translated for display by TigerLink.
4. Save As under a new name that identifies your language (e.g., Dansk.lng).
5. Translate the phrases into your language. Make sure you keep them about the same length as the
English original, otherwise you may find the text truncated (cut off) in some locations.
6. When you are finished, Save the new language file.
7. Select your new file as the new language. TigerLink will take the text from this file for display.

Design a label layout?
The "Label Designer" main window (Fig. 1) is opened from TigerLink's main application window using
the "Label" drop-down menu. Click on "Design a label" (Fig. 2) and the "Label Designer" main window
will open.

Fig. 1
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Fig. 2

Blank default label

Fig. 3
The label designer will open a blank default label (Fig. 3) if this is your first label; otherwise it will open
the label that is set in your printing configuration.
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The size of the labels for a 2” printer is 2.20” wide
by 1.25” high.
If you have a 4” printer, you will have to adjust the
size of the label.
See the Label Designer tutorial for how to do this.
The items under “List of variables” are the fields
you can use to print your labels. All the fields that
you are working with will be displayed in the lower
window (Fig. 4).

Fig. 4

Drag and drop fields from variable list to design window
To print a field, simply drag-and-drop that field from the list of variables in the lower half of the label
designer into the design window in the upper half.

Adjust field sizes as they will display on the label

Fig. 5
When you have dragged the field over the label design area, you will a marquee bounding box for that
field (Fig. 5). At this point you can resize the field, or you resize it after you locate its final position on the
label.
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Display the field name by releasing the mouse button

Fig. 6
When the mouse button is released, the field name will be displayed (Fig. 6). With the field selected, grab
the border of the field box. The cursor will turn into a movement cursor when you are in the right
position. While you hold the left mouse button down, you will be able to move the field around on the
label. When you are satisfied with the position of the label, release the mouse button.

Final positioning of the label fields

Fig. 7
The field will print on the real label just as it appears on the virtual label. To see how the label will look
when printed on a printer, switch to the layout preview mode (Fig. 8).
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Fig. 8
The field will be displayed as it would appear on a real label along with actual data to help with
positioning the field better. If there is nothing after the = sign, do not worry, the data would come from
one of your cut list files if you had previously opened one. Notice that the field box has resizing handles
on it. Grab the lower right handle and resize the field so you can see the entire field (Fig. 9).

Fig. 9
Repeat for all of the fields that you want to appear on the label. You will probably want to Save As, using
another filename so you can keep a clean copy of the original label.
Be sure to save your label! Also be sure to set this label file as the one you want printed in the Printing
configuration.

Configure a custom job file?
If the user is not using "off the shelf" cut listing software, but instead uses spreadsheet or other software to
generate a cut list, TigerLink has a built-in utility that customizes the way that TigerLink reads job files.
It's a simple process and needs to be done only once (unless the file structure changes).
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To configure a custom job file, use the File Configuration Wizard. A complete step by step guide to this
utility begins at Fig. 17 "File Configuration Wizard" in the TigerLink Reference: Screen Shot Library.

Change the language in the controller?
For TigerLink versions 5.1 and later only!
The TigerStop controller display messages are character strings residing in a plain ASCII text file, one
string per line and numbered. This is an excerpt from the English language file:
1 English
2 Pwr off to reset
3 SYSTEM ERROR 4
4 SYSTEM ERROR 1
5 SYSTEM ERROR 2
6 SYSTEM ERROR 0
The first line of any language file is the name of the language itself. Each line thereafter represents a
message that the controller will display at some point.

Create a new language file
To create a new language file, follow these steps:
1. Use this hyperlink to the English language file, and when prompted to [Open] or [Save], choose
[Save].
2. Save it on your computer to this location: C:\Program files\TigerStop\TigerLink\language files\.
3. Rename the file with your language, for example, for Danish you could call it "dan460.lang."
4. Translate the terms that you want into your language. Some terms are best left "as is."
1. Keep in mind that there is a limited space for the display, which is 16 characters wide,
including spaces.
2. In the English language file, some of the character strings fit in 8-character slots, others in 16
character slots.
3. Any English character string with at least 9 characters can be up to 16 characters long.
4. If your translated string is too long, it will be truncated.
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Upload your new language file to the controller

Fig. 1

Fig. 2
Fig. 3
To upload your new language file to the controller, follow these steps:
1. Start TigerLink. At the TigerLink Splash Screen, click [Continue] to open the main application
window (Fig. 1). The empty bottom half of the screen has been cut off to save space.
2. Click the "Send" drop-down menu, and click "Language" (Fig. 2).
3. The language file dialog box (Fig. 3) opens. Any language files that TigerLink can find in the
default language file directory will be listed in the window.
4. If the language file you created is not in the window, use [Browse] to look for it. [Browse] lets you
navigate to a different directory.
5. Select the language file that you want the controller to use. Two languages can be uploaded to the
controller at one time, a primary and a secondary language. The language in use can be toggled in
the controller. Select which language you want the controller to use and click the appropriate radio
button for primary (Fig. 4) and secondary language (Fig. 5).
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Fig. 4

Fig. 5

Select a destination TigerStop for each language

Fig. 6
With a language selected, choose a TigerStop from the drop-down combo box labeled "Destination", and
click [OK] or [Close] to send that language to the selected TigerStop's controller.
A progress bar will appear to show the progress of the language send operation.

Drag and copy work cell values?
You can make a column of cells have the same value.
For example, you may have a work order to which you've added a group of new lines of data (Fig. 1).

Fig. 1
Filling in all of the columns with values would be tedious. Select the cell into which you want to start
inputting new values. Type in a value for the cell (Fig. 2).
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Fig. 2
When the mouse cursor changes from a cross to a pointer, hold down the control key, then LEFT click
and drag the box outline to where you want the value to span to (Fig. 3).

Fig. 3
Let go the mouse button and the value will populate from the starting cell to the last cell you stopped at
(Fig. 4).

Fig. 4
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Screen Shot Library
Screen Shot Visual Directory
Screen shots are images of the screens displayed in TigerLink and Scheduler.

Fig. 3 - Properties Window
Fig. 1 - TL5 Splash Screen
Fig. 2 - Main Window

Fig. 5 - Part Select

Fig. 6 - Cutlist Configuration

Fig. 7 - Language Configuration

Fig. 8 - Settings Configuration

Fig. 9 - Printing Configuration

Fig. 10 - TigerServer Config.

Fig. 13 - Add Tab

Fig. 14 - Rename Tab

Fig. 4 - Navigation Bar

Fig. 11 - TigerStop Configuration

Fig. 12 - Filters Configuration

Fig. 15 - Delete Tab
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Fig. 16 - Configure the view

Fig. 17 - File Config. Wizard

Fig. 18 - File Config. browse

Fig. 19 - File Config. delimiter

Fig. 20 - File Config. length

Fig. 21 - File Config. quantity

Fig. 22 - File Config. select job

Fig. 23 - Create Col. Headers

Fig. 24 - Choose your sort

Fig. 25 - File Config. key fields

Fig. 26 - Main Screen Display

Fig. 27 - File Config. Custom Link

Fig. 28 - File Configuration Finish

Fig. 29 - Verify work orders up
Fig. 30 - Language

Fig. 34 - Scheduler main window
Fig. 31 - Label Designer main

Fig. 32 - Lab. Des. layout mode

Fig. 33 - Lab. Des. preview

Fig. 36 - Command window
Fig. 35 - Warning

Fig. 37 - Configure TigerStop

Fig. 39 - Status drop-down

Fig. 38 - Config. Misc settings

Fig. 40 - Released priorities

Fig. 42 - Scheduler Toolbar

Fig. 41 - Overdue work order
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Fig. 43 - TigerLink bug report

Fig. 44 - TLink feature request

Fig. 45 - About TL Debug off

Fig. 46 - About TL Debug is on

TigerLink Splash Screen
When TigerLink first starts up, a splash screen is displayed that contains various options (Fig. 1).

Fig. 1
The options shown in the splash screen are as follows:
1. Continue — This opens the TigerLink Main Window.
2. www.tigerstop.com — This links to the TigerStop corporate web site.
3. Exit — This closes TigerLink without using it.
4. Scheduler — This opens Scheduler.
5. Help — This opens the TigerLink 5.1 User Manual.
6. Show splash — This box is checked to display the splash screen, as a default.

TigerLink Main Window
Clicking on [Continue] at the TigerLink splash screen opens the main window (Fig. 2).
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Fig. 2
The various parts of the main window shown above are as follows:
1. The menu bar contains various functions and options as drop-downs.
2. The toolbar contains various tools for working in the main window.
3. The navigation bar contains buttons for four primary actions.
4. The properties window displays work order properties.
5. The work space is where work orders are displayed and manipulated.
6. The status bar shows the current status of the main window.

Properties Window
At the top of the main screen is an area called the properties window (Fig. 3).

Fig. 3
The various parts of the properties window excerpted above are as follows:
1. The "Work order#:" window displays the work order #. Just used for tracking purposes.
2. The "Active" check box sets the work order to be Active (checked) or Inactive (unchecked).
Active work orders are sent to TigerServer. Inactive work orders are not sent to TigerServer.
3. The "Destination" window is a drop-down displaying TigerStops on your system. It will
display the TigerStop to which the current work order is assigned. The destination of a work
order can also be assigned or changed here.
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4. "Linear" is a Read Only field that shows the total linear feet of material needed to fulfill the
work order.
5. The "Open files" window will display a list of the files that were used to obtain the work order
data.
6. The "Add comment" button lets you add a comment that is saved with the work order and
displayed to the machine operator.

Navigation Bar
In the left pane of the main screen is the navigation bar (Fig. 4).

Fig. 4
The 4 buttons in the navigation bar shown above are as follows:
1. [Grab Job] opens a dialog that allows the user to browse to and open a job file.
2. [Send] sends the active work orders to TigerServer.
3. [Scheduler] opens the Scheduler application.
4. [Print] prints the currently displayed work order.

Item/Part sorted by PART
The "Item/Part sorted by PART" window (Fig. 5a) opens from the Grab job window when you are in the
process of opening a work order.
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Fig. 5a
The various parts of the "Item/Part sorted by PART" window shown above are as follows:
1. The tabs along the top of the window are Part group tabs. There is only one tab "Frames" in
the example.
2. The "Destination" drop-down combo box is where you select the TigerStop that will process
these parts.
3. The "Enable printing" check box is where you turn label printing on and off.
4. The "Label file" box is where you select where to send the label data.
5. The left scrolling window is the "Part list" and shows all the parts in the job file.
6. The right scrolling window is the "Selected parts" list and shows only the parts you select for
the work order.
7. [>] adds any part selected from the "Part list" to the "Selected parts" list.
8. [>>] adds ALL parts in the "Part list" to the "Selected parts" list.
9. [<] removes any part selected from the "Selected parts" list.
10. [<<] removes ALL parts from the "Selected parts" list.
Options menu / Tab
The Tab menu (Fig. 5b) contains five options affecting tabs.
Fig. 5b
1. [Add new] adds a new tab to the dialog box.
2. [Rename tab] lets the user enter a new name for an existing
tab.
3. [Delete tab] permanently DELETES the tab and ALL its
contents.
4. [Hide tab] removes the tab from the display, but does NOT
delete it.
5. [Show tab] lets the user restore a hidden tab to the display.
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Options menu / Sort
The Sort menu (Fig. 5c) lists the fields (in the user's data file) that can be selected to display in the "Parts
list" window. Usually, this will be the "PART" field.
Fig. 5c

1. [JOB]
2. [PART]
3. [QUANTITY]
4. [MATERIAL]
5. [RMCAB]
6. [SEC]
7. [WIDTH]
8. [LENGTH]
9. [TOTALFT]
10. [THICKNESS]

Cutlist Configuration
The Configuration dialog is opened from TigerLink's main application window using the "Options" dropdown menu and selecting "TigerLink Configuration." When the Configuration dialog opens, click the tab
"Settings" (Fig. 6).
Cutlist configuration specifically refers to what work order program you will be using. Use the drop-down
combo box to find your software type.
Six other settings are also accessed at this tab. See the explanations below Fig. 6a.

Fig. 6a
The "Settings" tab of the "Configuration" window has the following parts:
1. The drop-down combo box labeled "Work order program" displays the name of the cut listing
software you are using, or your custom configuration.
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2.
3.
4.
5.
6.

"Show splash screen" check box turns the splash screen display at start up on or off.
"Show tooltips" check box turns interactive tool tips on or off.
"Show upload dialog" check box turns on a dialog box when uploading files to TigerServer.
"Metric" check box, if checked, will display ALL dimensions in metric units.
"Use job number from file" check box, if checked, uses the job number from your job file;
otherwise a random number is used.
7. The "Select background color" drop-down gives you alternate colors to use in TigerLink
screens (Fig. 6b). "Custom…" opens another dialog box which lets you specify a custom color.

Fig. 6b

Language Configuration
The Configuration dialog is opened from TigerLink's main application window using the "Options" dropdown menu and selecting "TigerLink Configuration." When the Configuration dialog opens, click the tab
"Language" (Fig. 7).

Fig. 7
The "Language" tab of the "Configuration" window has a single drop-down combo box:
1. "Current language" displays the default language of communication, English.
2. Select a new language from the drop-down list. Current alternate languages: español, français
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Settings Configuration
The Configuration dialog is opened from TigerLink's main application window using the "Options" dropdown menu and selecting "TigerLink Configuration." When the Configuration dialog opens, click the tab
"Settings" (Fig. 8a).

Fig. 8a
The "Settings" tab of the "Configuration" window has the following parts:
1. The drop-down combo box labeled "Work order program" displays the name of the cut listing
software you are using, or your custom configuration.
2. "Show splash screen" check box turns the splash screen display at start up on or off.
3. "Show tooltips" check box turns interactive tool tips on or off.
4. "Show upload dialog" check box turns on a dialog box when uploading files to TigerServer.
5. "Metric" check box, if checked, will display ALL dimensions in metric units.
6. "Use job number from file" check box, if checked, uses the job number from your job file;
otherwise a random number is used.
7. The "Select background color" drop-down gives you alternate colors to use in TigerLink
screens (Fig. 6b). "Custom…" opens another dialog box which lets you specify a custom color.

Fig. 8b
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Printing Configuration
Printing configuration is set up on a per tab basis at the "Item/Part sorted by PART" screen (Fig. 9). This
screen displays whenever you open a job file.

Fig. 9
The "Item/Part sorted by PART" dialog is where label printing is configured:
1. The "Enable printing" check box, if checked, label printing will be enabled, if unchecked, label
printing will NOT be enabled.
2. The "Label file" box displays the name and path of the label file to print.
3. The […] button opens a file browse window to select a different label file.

TigerServer Configuration
The Configuration dialog is opened from TigerLink's main application window using the "Options" dropdown menu and selecting "TigerLink Configuration." When the Configuration dialog opens, click the tab
"TigerServer" (Fig. 10).
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Fig. 10
The "TigerServer" tab of the "Configuration" window has the following parts:
1. The network computer name of the computer that is running TigerServer is displayed in the
box labeled "Name of the computer hosting TigerServer."
2. The […] button opens a list of the computers on the network allowing you to choose a
computer to run TigerServer.

TigerStop Configuration
The Configuration dialog is opened from TigerLink's main application window using the "Options" dropdown menu and selecting "TigerLink Configuration." When the Configuration dialog opens, click the tab
"TigerStop" (Fig. 11).

Fig. 11
The "TigerStop" tab of the "Configuration" window has the following parts:
1. The spreadsheet window displays information for all configured TigerStops.
2. [Add] lets you add a new TigerStop to your configuration.
3. [Edit] lets you edit the TigerStop information.
4. [Delete] deletes the selected TigerStop from your configuration.
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Filters Configuration
The Configuration dialog is opened from TigerLink's main application window using the "Options" dropdown menu and selecting "TigerLink Configuration." When the Configuration dialog opens, click the tab
"Filters" (Fig. 12).

Fig. 12
The "Filters" tab of the "Configuration" window has the following parts:
1. A listing of the available fields to filter the data with is displayed on the left.
2. A listing of the data filters you select will appear on the right.
3. [>] adds the selected filter to the window on the right.
4. [>>] adds ALL the filters to the window on the right.
5. [<] removes the selected filter from the list on the right.
6. [<<] removes ALL the filters from the list on the right.

Add New
The "Add tab" dialog (Fig. 13a) is opened by clicking [Options], [Tab] and [Add new] in the Item/Part
sorted by PART dialog box (Fig. 13b).
Fig. 13a
Fig. 13b

The "Add tab" dialog has the following parts:
1. The box labeled "Enter a name for the new tab" is where you name your new tab.
2. [OK] accepts and saves the new tab.
3. [Cancel] cancels the new tab and exits the dialog.
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Rename Tab
The "Rename" dialog (Fig. 14a) is opened by clicking [Options], [Tab] and [Rename tab] in the Item/Part
sorted by PART dialog box (Fig. 14b).
Fig. 14a
Fig. 14b

The "Rename" dialog has the following parts:
1. The box labeled "Type in the new name for tab" is where you rename an existing tab.
2. [OK] accepts and saves the new name.
3. [Cancel] cancels the rename and exits the dialog.

Delete Tab
To delete a tab, click [Options], [Tab] and [Delete Tab] in the Item/Part sorted by PART dialog box (Fig.
15a). A message asking you to confirm the delete command appears (Fig. 15b).
Fig. 15a
Fig. 15b

The "Confirm delete" dialog has the following parts:
1. [Yes] will delete the tab.
2. [No] cancels the delete command and exits the dialog.

Configure the view
The "Configure the view" dialog (Fig. 16) is opened from TigerLink's main application window using the
"Options" drop-down menu. Click on "Options" and then move the cursor over "Advanced" which will
display a drop-down containing three more options. Click on "Configure view" and the "Configure the
view" dialog will open.
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Fig. 16
The "Configure the view" dialog has the following parts:
1. "Column name" lists available field names.
2. "Column #" check boxes, if checked the column will be visible in the work space, if
unchecked the column will not be shown in the work space.
3. The "Up arrow" moves the column up in the order of display. “Up” is equal to moving the
column to the LEFT in the work space.
4. The "Down arrow" moves the column down in the order of display. “Down” is equal to
moving the column to the RIGHT in the work space.
5. [Restore default] restores the view to the original display setup.
6. [OK] accepts the selection.
7. [Cancel] cancels the selection and exits the dialog box.

File Configuration Wizard
The File Configuration Wizard is a series of help screens. To get to it, you start at TigerLink's main
application window using the "Options" drop-down menu. Click on "Options" and then move the cursor
over "Advanced" which will display a drop-down containing three more options. Click on "File
configuration" and the "File Configuration Wizard Introduction" screen (Fig. 17) will open.
Who should use the File Configuration Wizard? Anyone who is NOT using 'off the shelf' cut listing
software.
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Fig. 17
File Configuration Wizard Introduction screen
This is just an opening screen. It gives you instructions on backing out of it, so you can check the standard
defaults. When once you have checked to see that the program you use to generate cut lists is NOT listed
in the standard defaults, you come back to this screen and continue by clicking [Next>>].
As usual, [Cancel] backs you out of this screen.

File Configuration browse
Clicking [Next>>] at the File Configuration Wizard screen takes you to the first screen of the wizard, the
"browse for data file" screen (Fig. 18).

Fig. 18
File Configuration 'browse for data file' screen
1. […] lets you look for the file you want to use. When you find it, it will automatically fill in the
window labeled "Browsing for your data file."
2. You can also enter a path and file name manually into the window.
3. [<<Back] returns you to the previous screen, [Cancel] exits the program, or continue by
clicking [Next>>].

File Configuration delimiter
Clicking [Next>>] at the File Configuration browse screen takes you to the next screen of the wizard, the
"select delimiting character" screen (Fig. 19).
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Fig. 19
The File Configuration 'select delimiting character' screen has the following parts:
1. The window labeled "Line of data from your file" displays a line of data from the file that was
selected at the previous screen.
2. The selection cursor is shown above highlighting the comma after JOB.
3. [<] moves the selection cursor one character to the LEFT.
4. [>] moves the selection cursor one character to the RIGHT.
5. [Up] displays the previous line in the data file.
6. [Dn] displays the next line in the data file.
7. [<<Back] returns you to the previous screen, [Cancel] exits the program, or continue by
clicking [Next>>].

File Configuration length
Clicking [Next>>] at the File Configuration delimiter screen takes you to the next screen of the wizard,
the "select the length column" screen (Fig. 20). Highlight the length column by clicking on it, then click
[Next>>].
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Fig. 20
The File Configuration 'select the length column' screen has the following parts:
1. [Up] displays the previous line in the data file.
2. [Down] displays the next line in the data file.
3. [<<Back] returns you to the previous screen, [Cancel] exits the program, or continue by
clicking [Next>>].

File Configuration quantity
Clicking [Next>>] at the File Configuration length screen takes you to the next screen of the wizard, the
"select the quantity column" screen (Fig. 21). Highlight the quantity column by clicking on it, then click
[Next>>].

Fig. 21
The File Configuration 'select the quantity column' screen has the following parts:
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1. [Up] displays the previous line in the data file.
2. [Down] displays the next line in the data file.
3. [<<Back] returns you to the previous screen, [Cancel] exits the program, or continue by
clicking [Next>>].

File Configuration select job
Clicking [Next>>] at the File Configuration quantity screen takes you to the next screen of the wizard, the
"select the job column" screen (Fig. 22). This is an OPTIONAL step. Highlight the job column by
clicking on it, then click [Next>>].

Fig. 22
The File Configuration 'select the job column' screen has the following parts:
1. [Up] displays the previous line in the data file.
2. [Down] displays the next line in the data file.
3. A sample of what your work order number might look like, if it is numeric, is displayed below
the data window.
4. The starting number of sequential work order numbering is displayed in a field below the data
window. The arrows at the starting number field let you decrement (<1000) or increment
(>1000) the starting number.
5. [<<Back] returns you to the previous screen, [Cancel] exits the program, or continue by
clicking [Next>>].
Using sequential work order numbering
If you select the job column, a sample of what your work order number might look like, if it is numeric, is
displayed below the data window, and sequential numbering is DISABLED. TigerLink captures only the
first six digits of your work order number, and they must be numbers. TigerLink discards any letters. If
your work order number consists of letters only, it will display as 0 (Fig. 22).
If you do NOT select the job column, TigerLink will use a sequential number to identify work orders,
starting with 1000. By not selecting the job column and enabling sequential numbering, you can use an
auto-generated sequential number, or you can insert a number of your choice in the starting number box
as the starting number of a sequence.
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Create Column Headers
Clicking [Next>>] at the File Configuration select job screen takes you to the next screen of the wizard,
the "Create Column Headers" screen (Fig. 23a). This screen lets you use the field names from your cut list
data as the column headers, or create new column headers.

Fig. 23a
The File Configuration 'Create Column Headers' screen has the following parts:
1. Check box labeled "Use my field names…", if checked will use the field names assigned by
your cut listing software (Fig. 23b), if unchecked, you can enter new names on the appropriate
lines in the "Name" window on the right. If you do assign new names, when you're done,
clicking [Next>>] saves and exits this screen.
2. [<<Back] returns you to the previous screen, [Cancel] exits the program, or continue by
clicking [Next>>].
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Fig. 23b

Choose your sort
Clicking [Next>>] at the Create Column Headers screen takes you to the next screen of the wizard, the
"Choose your sort" screen (Fig. 24). This screen lets you create separate work orders for your original job
file data, based on sorting criteria you choose.

Fig. 24
The File Configuration 'Choose your sort' screen has the following parts:

84

TigerLink Reference
1. Check boxes in the "Use as filter" window, if checked, will use the column in the "Name"
window as filters.
2. [<<Back] returns you to the previous screen, [Cancel] exits the program, or continue by
clicking [Next>>].

File Configuration key fields
Clicking [Next>>] at the Choose your sort screen takes you to the next screen of the wizard, the "Select
key fields" screen (Fig. 25).

Fig. 25
The File Configuration 'Select key fields' screen has the following parts:
1. The window on the left lists the filters you selected at the previous screen.
2. The window on the right is where you select up to three filters to be key fields.
3. [<<Back] returns you to the previous screen, [Cancel] exits the program, or continue by
clicking [Next>>].

Main Screen Display
Clicking [Next>>] at the File Configuration key fields screen takes you to the next screen of the wizard,
the "Main Screen Data Display" screen (Fig. 26). It is at this screen that you select which fields will
appear in TigerLink's main window.
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Fig. 26
The File Configuration 'Main Screen Display' screen has the following parts:
1. The window on the left lists the fields in your job file.
2. The window on the right is where you select which fields will be visible at TigerLink's main
window.
3. All the check boxes in the white window are checked by default. Uncheck any box to remove
the field from the main window. In the example (Fig. 26) two fields have been unchecked.
4. [<<Back] returns you to the previous screen, [Cancel] exits the program, or continue by
clicking [Next>>].

File Configuration Custom Link
Clicking [Next>>] at the Main Screen Display screen takes you to the next screen of the wizard, the "File
Configuration Custom Link" screen (Fig. 27). It is at this screen that you add a name to your custom link.
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Fig. 27
The File Configuration 'Custom Link' screen has the following parts:
1. An empty window in which you enter a name for your custom link.
2. [<<Back] returns you to the previous screen, [Cancel] exits the program, or continue by
clicking [Next>>].

File Configuration Finish
Clicking [Next>>] at the File Configuration Custom Link screen takes you to the next screen of the
wizard, the "File Configuration Finish" screen (Fig. 28). Clicking [Finish] at this screen saves your work
and exits.

Fig. 28
The File Configuration 'Finish' screen has the following parts:
1. [<<Back] returns you to the previous screen, [Cancel] exits the program, or save your work
and exit by clicking [Finish].
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Verify work orders to upload
When you click [Send] in the navigation bar of the TigerLink main application window, the "Verify work
orders to upload" dialog box opens (Fig. 29), to let you have another chance to send work orders. You can
uncheck work orders that are not quite ready to go to the TigerServer.
If you want to bypass this dialog box in the future, uncheck "Show dialog."
Work orders with an INACTIVE status are NOT sent to TigerServer.

Fig. 29
The 'Verify work orders to upload' dialog has the following parts:
1. The name of the part group is shown outdented.
2. The check boxes set the work orders to Active or Inactive. Unchecked = Inactive. Inactive
work orders are not sent to the TigerServer.
3. The check box labeled "Show dialog" shows or hides the dialog box.
4. [OK] accepts the selections made, sends them to TigerServer, and opens the Scheduler main
window.
5. [Cancel] cancels any selection changes and exits the dialog.

Language
The "Language" dialog (Fig. 30) is opened from TigerLink's main application window using the "Send"
drop-down menu. Click on "Language" and the "Language" dialog will open.

Fig. 30
The 'Language' dialog has the following parts:
1. The language window will display a list of available language files.
2. "Primary language" radio button selects the highlighted language as the primary language.
3. "Secondary language" radio button selects the highlighted language as the secondary language.
4. [OK] uploads the selected language file to TigerStop and leaves the dialog open when
complete.
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5.
6.
7.
8.

[Close] uploads the selected language file and then closes the dialog afterwards.
[Cancel] cancels the language upload and closes the dialog.
"Destination" drop-down combo box selects which TigerStop to send the language file to.
[Browse] lets the user browse another directory to find language files.

Label Designer main window
The "Label Designer" main window (Fig. 31) is opened from TigerLink's main application window using
the "Label" drop-down menu. Click on "Design a label" and the "Label Designer" main window will open.

Fig. 31
The 'Label Designer' main window has the following parts:
1. The label image in the large window in the upper right is a visual representation of what the
label printer will print.
2. Below the label image window is a list of the fields are available to print.
How to add a field to the label
Drag the name of the variable that is to be printed from the list of fields on to the label. Then drag and
drop the field to position the print field where you want it to be printed on the label.

Label Designer layout mode
The "Label Designer" main window in layout mode (Fig. 32) displays the "Layout" tab above the field list
window in color.
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Fig. 32
The 'Label Designer' main window in Layout mode.

Label Designer layout preview
The "Label Designer" main window in preview mode (Fig. 33) displays the "Layout Preview" tab above
the field list window in color.
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Fig. 33
The 'Label Designer' main window in Layout Preview mode.
If the user has previously opened a file, that file will be used to get sample data to populate the fields.
If the Label Designer is in Layout Preview mode, this will be shown. The Label Designer can show the
user a fairly good representation of what the label will actually look like when printed.

Scheduler Main Window
The "Scheduler" main window (Fig. 34) opens when you click the Scheduler desktop
icon.

Fig. 34
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The Scheduler main window has the following parts:
1. At the top the drop-down menus: File, Edit, View, Tools, Help.
2. Below the drop-down menus: a toolbar.
3. At the bottom left of the screen: destination tabs.
4. The spread sheet window displays the work orders.
Back to Starting Scheduler or continue to more Scheduler topics…
Warning Command window Configure TigerStop Configure Miscellaneous settings
Status drop-down Released priorities Overdue work order
Scheduler Toolbar

Warning
The "Warning" window (Fig. 35) is opened from Scheduler's main application window using the "View"
drop-down menu. Click on "Command Window" and the "Warning" window will open.

Fig. 35
The 'Warning' pop up has these features:
1. You must enter the password 81550 in the box at the lower left in order to continue.
2. Click [Yes] to continue to the actual Command window.
3. Click [No] to exit the program.
Back to Scheduler Main Window or continue to more Scheduler topics…
Command window Configure TigerStop Configure Miscellaneous settings
Status drop-down Released priorities Overdue work order
Scheduler Toolbar

Command Window
The "Command" window (Fig. 36) opens when you enter the password and click [Yes] at the "Warning"
window.
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Fig. 36
The 'Command' window has these parts:
1. A list of available TigerStops appears in the drop-down combo-box next to [Connect].
2. [Connect] connects to the TigerStop selected in the drop-down combo box.
3. Click [Send] to continue.
4. Click [Close] to exit the program.
Back to Warning or continue to more Scheduler topics…
Configure TigerStop Configure Miscellaneous settings
Status drop-down Released priorities Overdue work order
Scheduler Toolbar

Configure TigerStop
The "Configure TigerStop" window (Fig. 37) is opened from Scheduler's main application window using
the "Tools" drop-down menu. Click on "Configuration" and the "Configuration" window will open.
In Scheduler, "Configure TigerStop" works the same way as it does in TigerLink.

Fig. 37
The 'Configure TigerStop' window has these parts:
1. The spreadsheet window displays information for all configured TigerStops.
2. [Add] lets you add a new TigerStop to your configuration.
3. [Edit] lets you edit the TigerStop information.
4. [Delete] deletes the selected TigerStop from your configuration.
Back to Command window or continue to more Scheduler topics…
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Configure Miscellaneous settings Status drop-down Released priorities
Overdue work order Scheduler Toolbar

Configure Miscellaneous Settings
The "Misc settings" window (Fig. 38) is opened from Scheduler's main application window using the
"Tools" drop-down menu. Click on "Configuration" and the "Configuration" window will open.

Fig. 38
The 'Misc settings' window has these parts:
1. "Fade" check box, if checked, causes work orders to gradually fade from view instead of
suddenly disappear, after they are processed.
2. "Auto refresh" check box, if checked, enables automatic refreshing of data in the time set.
3. "Refresh interval" drop-down combo box lets you set the time in minutes for auto refresh.
4. "Server name" displays the name of the computer that is running TigerServer.
5. [OK] accepts and saves any changes.
6. [Cancel] exits the screen without saving.
Back to Configure TigerStop or continue to more Scheduler topics…
Status drop-down Released priorities Overdue work order Scheduler Toolbar

Status drop-down
The Scheduler main window displays work orders in spread sheet fashion (Fig. 39a).

Fig. 39a - Scheduler main window
1. UNRELEASED work orders have Priority 0 (column 1). See Released priorities.
2. Work orders can be searched for at the TigerStop controller by work order number column 3).
3. Comments can be entered for work orders (column 4).
4. Destination can be changed per work order (column 14).
5. Status can be changed per work order using the Status (column 15) drop-down combo box (Fig.
39b).
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Fig. 39b
Scheduler Status drop-down
6. RD = Released = This work order can be viewed at the destination TigerStop controller.
7. PT = Permanent = This work order will not be automatically deleted by the program after it is
run, but will remain in memory at Permanent Pending status.
8. UR = Unreleased = This work order cannot be viewed at any TigerStop.
9. PR = Permanent Released = This work order can be viewed at ANY TigerStop on the system.
10. PP = Permanent Pending = The state of a Permanent work order after it has been processed. It
can be set to PR status to process it again.
Back to Configure Miscellaneous settings or continue to more Scheduler topics…
Released priorities Overdue work order Scheduler Toolbar

Released priorities
The Scheduler main window displays work orders in spread sheet fashion, assigning priority to them in
the order which they were released (Fig. 40).

Fig. 40 - Scheduler main window showing Released priorities
1. Priority can be manually changed in column 1.
2. Status of work orders with priorities greater than 0 will always be RD or PR.
Back to Status drop-down or continue to more Scheduler topics…
Overdue work order Scheduler Toolbar

Overdue work order
The Scheduler main window displays work orders in spread sheet fashion, assigning priority to them in
the order which they were released. Any work order beyond its Due date will display in RED (Fig. 41).

Fig. 41 - Scheduler main window showing Released work order beyond its Date due.
Back to Released priorities or continue to more Scheduler topics… Scheduler Toolbar
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Scheduler Toolbar

Fig. 42 - Scheduler Toolbar has the following tools:
1. "Down Arrow" moves the selected work order DOWN in priority.
2. "Up Arrow" moves the selected work order UP in priority.
3. "Circular Arrows" refreshes the data (same as hitting F5).
4. "Bug Icon" opens the Bug Report form.
5. "Light Bulb" opens the Feature Request form.
6. "Question Mark" opens Help.

TigerLink Bug Report
The TigerLink Bug report form (Fig. 43) is opened from Scheduler's main application window using the
"Help" drop-down menu. Click on "Submit bug report" and the TigerLink Bug report form will open.
The TigerLink Bug report form can also be opened from the TigerLink main window, using the Help
drop-down menu.
This is provided to the user, so any bugs in the software can be documented and submitted to TigerStop
for correction.

Fig. 43 - TigerLink bug report has the following auto-generated texts:
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1.
2.
3.
4.
5.
6.

[To:] auto-fills TigerStop's development team email address.
"Subject" auto-fills "TigerLink bug report."
"Title =" is where you write a brief descriptive title of the bug.
"Progress Status =" should be left alone.
"Type of change =" already filled in, leave alone.
"Version =" is where you put the version number of the software that has the bug. The version
number is found in the "About" dialog.
7. "Originator name =" is where you enter the name of the person making the report.
8. "Originator email =" is where you enter the email address of the person making the report.
9. "Originator phone =" is where you enter the phone number of the person making the report.
10. [Issue description] is where you describe the bug.
When making a bug report, give as much information as possible!
Include the steps required to replicate the problem, as well as any error messages encountered. To simply
say "Doesn't work," or "It's broke," will not give us anything to work with. If we cannot replicate the bug
you are experiencing, we cannot solve it!

TigerLink Feature Request
The TigerLink Feature request form (Fig. 44) is opened from Scheduler's main application window using
the "Help" drop-down menu. Click on "Submit feature request" and the TigerLink Feature request form
will open.
The TigerLink Feature request form can also be opened from the TigerLink main window, using the Help
drop-down menu.
This request form is provided to the user, so suggestions for improvements in the software can be
documented and submitted to TigerStop for review.
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Fig. 44 - TigerLink feature request has the following auto-generated texts:
1. [To:] auto-fills TigerStop's development team email address.
2. "Subject" auto-fills "TigerLink feature request."
3. "Title =" is where you write a brief descriptive title of the feature.
4. "Progress Status =" should be left alone.
5. "Type of change =" already filled in, leave alone.
6. "Version =" is where you put the version number of the software that has the bug. The version
number is found in the "About" dialog.
7. "Originator name =" is where you enter the name of the person making the report.
8. "Originator email =" is where you enter the email address of the person making the report.
9. "Originator phone =" is where you enter the phone number of the person making the report.
10. [Issue description] is where you describe the feature you would like to see.
When making a feature request, give as much information as possible!
The more information that is included, the more likely it is that the feature would be done in accordance
with the user's wishes. The description should answer these questions: What? Why? and How?
 What is the feature that you want to be implemented?
 Why do you want the software to do this?
 How do you want the software to do this?
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If a feature request does not give us enough information to evaluate it for development, it will simply not
be accepted.

About TigerLink
Debug Off
The "About TigerLink" screen (Fig. 45) is opened from TigerLink's main application window using the
"Help" drop-down menu, and clicking "About TigerLink."
Besides looking at the version numbers, use this screen also to check to see whether debug mode is turned
on or off.

Fig. 45 - About TigerLink window, with Debug Off
How to turn debug mode ON
Hold down the Alt key and hit the F10 key on your computer keyboard. This is a toggle to turn debug
mode ON or OFF.

About TigerLink
Debug On
The "About TigerLink" screen (Fig. 46) is opened from TigerLink's main application window using the
"Help" drop-down menu, and clicking "About TigerLink."
Besides looking at the version numbers, use this screen also to check to see whether debug mode is turned
on or off.
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Fig. 46 - About TigerLink window, with Debug On
How to turn debug mode OFF
Hold down the Alt key and hit the F10 key on your computer keyboard. This is a toggle to turn debug
mode ON or OFF.

TigerLink Fundamentals
Registry entries
WARNING! Editing the registry can seriously damage your computer system. Do not edit the
registry manually unless you are very sure of what you are doing!
The registry entries for TigerLink are located in HKLM\Software\TigerStop\Product Manager\Version 1.0
HKEY_LOCAL_MACHINE
____Software
________TigerStop
____________Product manager
________________Version 1.0
____________________Configuration
AppPath
FirstRun
LastFileOpened

String—The application path
String—Flag if the app has run for the first time or not
String—Path to the last file opened

Configuration
CutlistExtension
CutlistProgram

String—The extension for the job files
String—The name of the cut list program
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Debug
Definition
EnableRefresh
EnableSplash
Fade
JobFromFile
Lang file
Language
PrintEnable
PrintLabel
RefreshTime
ResourceDLL
Sequence
ServerName
ShowToolTip
ShowUploadDlg
SourceDir
UOM

String—TRUE if in debug mode
String—The name of the cut list definition file
String—TRUE if auto refreshing is enabled
String—TRUE if the splash screen is to be shown
DWORD—1 if the Scheduler jobs fade from view
BOOL—TRUE if the job numbers are taken from the job file
String—The name of the language file
String—The display language
String—TRUE if printing is enabled
String—Path and name of the label file to print
String—Time in minutes to refresh the display
String—The name of the resource DLL
DWORD—The sequence number for work orders
String—The name of the server computer
DWORD—1 if tool tips are to be shown
String—TRUE if the dialog is to be shown
String—The directory where job files are kept
BOOL—0 for English, 1 for metric

Directory structure
The default installation directory is C:\Program files\TigerStop\TigerLink.
\cutlists
\def
\default
\filters
\language files
\logs
\temp
\tigerserver
\tutorials

Saved cut list files are stored here
Definition files are stored here
Original files are stored here
Part select filter files are stored here
Language files are stored here
Log files for debugging are stored here
Temporary files are stored here
The TigerServer files are stored here
The tutorials are stored here

Filter files
The filter files are plain ASCII text files (*.flt files) that TigerLink uses to populate the Item/Part sorted
by PART window.
Each tab that is created will be saved as a different file.
Upon entering the Parts select dialog, all of the filter files are read, the tabs created, and the parts are
displayed. The structure of the file is very simple.
Note that the lines in the files are not numbered. The numbers below are just used for illustration purposes.
This is an example filter file:
1. Frames
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2.
3.
4.
5.

Frame saw
Bottom rail
Top rail
Rail

What does it mean?
Line 1 is the name of the tab as the user named it. In this case Frames.
Line 2 is the destination TigerStop, if the user has assigned a destination. If a destination has not been
assigned, then this line will be blank.
Lines 3, 4 and 5 are the parts that the user has previously selected that are used to populate the selected
parts side of the Parts select window.

Profiles
A profile is what is used by TigerLink to read the various kinds of data files. The profile is stored in an .ini
file as plain ASCII text. A typical profile looks like:
[Custom]
Name=Custom
HeadersInFile=1
Delimiter=,
Extension=.csv
Headers=Filename|JOB|PART|QUANTITY|MATERIAL|RM-CAB#|SEC#|WIDTH|LENGTH|TOTALFT|THICKNESS
NumberOfColumns=10
IgnoreComma=0
IgnoreBlanks=1
IgnoreNonData=1
EnableNoise=0
NoiseLevel=3
Length=LENGTH
Quantity=QUANTITY
Job=JOB
Filters=No filters selected
Visible=11111111111
What does it mean?
Name – is the name of the profile
HeadersInFile – the data files contain the header information
Delimiter – the field delimiter that the file uses
Extension – the file extension for the job files
Headers – a listing of the fields headers
NumberOfColumns – the number of fields that are in your job file
IgnoreComma – tells the parser to ignore commas embedded within the data
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IgnoreBlanks – tells the parser to ignore blank lines
IgnoreNonData – tells the parser to ignore lines that contain more fields than the NumberOfColumns
EnableNoise – tells the parser to limit the amount of data that is to be displayed
NoiseLevel – Tells the parser the number of blanks fields that are allowed to be displayed. Lines of data
that contain this number or more empty fields will be ignored
Length – the name of the field that contains the length information
Quantity – the name of the field that contains the quantity of the items
Job – the name of the field that contains the job number data
Filters – is the name of the field or fields that will be used to filter the data
KeyFields – the fields that the will be used to uniquely identify the cutlist
Visible – is an indication if the column will be visible or not. 1 = show the field, 0 = do not show the field.

Work order number
There are 3 parts of the work order number (Fig.1) to help identify it from other work orders.






Fig. 1
The first number is a number chosen at random. Could be any number. If the user has chosen to
have the job number be the work order number, then the first part of the work order number will
be that identifier.
The second section is the TigerStop or section that the work order has been assigned to. In this
case, we have a TigerStop that is name “Frames” which probably in somewhere in a frames
section of the work place.
The last part of the work order number is a sequential number identify the order in which the work
order was created. This work order number is from the first work order that was created.

Log files
What is a log file?
 A log file is an aid to troubleshooting, but it may not lead you to the exact problem. It will narrow
the scope greatly though.
 Log files are created by date in the form of mdyyyy.
 Log files from previous days are deleted by TigerLink.
How and when is a log file created?
While debug mode is on (toggle ON and OFF using Alt + F10), each function that is called writes an entry
into the log file when it begins and when it ends. This can slow down execution of the program so use
debug mode sparingly. Each entry into the log file is day and time stamped so we can follow the execution
of the program and narrow down where the defect/problem could be.
If the program crashes in the middle of a function call, that function will record that it began but there will
not be a corresponding entry that the function exited.
Needless to say that when debug mode is turned on, the log file can grow very large, very quickly. The
best thing to do is to turn the debug mode on right before the problem occurs and then turn the debug
mode off. That will keep the log file down in size and only provide the information that we really need.
The easier it is to go through the log file, the quicker it will be to solve the problem.
This is an excerpt from a log file:
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7/7/2005 - 10:55:52 End of CProductManagerView::OnBnClickedGrabFile
7/7/2005 - 10:56:5 CMainFrame::OnWindowPosChanging
7/7/2005 - 10:56:5 CProductManagerView::SetupButtons
7/7/2005 - 10:56:5 End of CProductManagerView::SetupButtons
7/7/2005 - 10:56:5 End of CMainFrame::OnWindowPosChanging
7/7/2005 - 10:56:5 CMainFrame::OnWindowPosChanging
7/7/2005 - 10:56:5 CProductManagerView::SetupButtons
7/7/2005 - 10:56:5 End of CProductManagerView::SetupButtons
7/7/2005 - 10:56:5 End of CMainFrame::OnWindowPosChanging

Cut list files
The cut lists are saved in the cut list directory with a .tsc extension.
The file is a binary file, unsuitable for viewing in notepad or other text viewers. Along with the .tsc file,
an .rs file is created that contains the cut list data for the .tsc file. The .rs file is a plain ASCII text file that
we write ourselves whenever a cut list is saved. The .rs file is read into the program database when the
user wants to load the cut list back into memory.
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What does this mean?

“The server cannot be started. TigerLink may not work correctly.”




When TigerLink starts up, it checks to make sure TigerServer is running.
If TigerServer is not running, TigerLink will attempt to start it.
If the attempt is not successful, you are notified that TigerServer is not running and you may not
be able to perform all of the functions as if the TigerServer was running.

“TigerServer is not running or is an incorrect version. TigerLink
exiting.”




When TigerLink starts up, it queries TigerServer for its version number. This verifies that
TigerServer is running and is compatible with TigerLink.
Some earlier versions of TigerServer will not operate correctly with later versions of TigerLink.
Make sure that your system is running the latest version of TigerLink and TigerServer.

“No cutlists available. PM Server offline.”
1. There are several possibilities that cause this problem:
1. Verify that TigerServer is in fact running.
2. Verify that the controller is plugged into the correct comport on the computer.
3. Verify that the controller is level 3 or above.
4. Verify that TigerServer is configured to open the comport that the controller is attached to.
5. Verify that TigerServer is using the correct baud rate. The baud rate must match the
controller’s baud rate.
6. Verify that the work orders have been sent to the TigerServer.
7. Verify that the work orders were set to RELEASED status in the Scheduler.
2. This problem has also been seen when the computer contained more than one copy of TigerServer.
Search the computer for TigerServer.exe and delete the extra copies.

"There was a problem reading the input file. The information
displayed may not be correct. Check the source file for errors."
This error means that TigerLink has encountered some kind of error while reading your job file. If
TigerLink displays a partial listing of your file, then you probably have a character in one of the fields that
is causing the read operation to terminate prematurely.
The most likely cause for this error is a double quote character. CSV files generally denote character
strings within double quotes. For example:
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"DRAWER SIDE","",2,"1/2 WHITE MELAMINE","1-1","1-1",4.125,22,"",1,0,"","","WHITE
PVC","","","E31Z00Q0","","","","","",""
The character strings are contained within double quotes, e.g., “DRAWER SIDE” ,while numbers do not
have quotes around them. TigerLink strips the quote characters out of the strings while processing the job
file, because the quotes are not needed.
Now what would happen if a quote character was inside one of the strings?
,"1/2" WHITE MELAMINE",

Here we have added a double quote character indicating that the material is 1/2 inch in one of the
dimensions. TigerLink reads the line and begins parsing the data out. We know that the comma separates
the data fields so we find the first comma and the subsequent double quote character. Those characters are
expected to be there. Now right after the 2 we find another double quote character but we do not have an
expected comma afterwards. TigerLink does not know what to do with that situation, so it displays the
error message.
Removing the extraneous double quote character, 1/2 WHITE MELAMINE, should cause TigerLink to read
the file normally again.

What is error 3265?
Error 3265 means that we tried to read a value from the database that does not exist. TigerLink reads the
label print data from the database and sends that information along with the work order.
 We get an error 3265 when the field names in the database and the "fieldname" in the label file do
not match.
 Disabling the printing in the configuration will work around the problem. See figure 9.
 You can open the label designer and delete the offending field from the label. Make sure that the
label file in the print configuration is the correct label file. Also the label designer cannot process
quite a few characters. The “legal” character set for the label designer is a – z, A – Z, . (period),
and _ (underscore). Any of the illegal characters are supposed to be replaced with an underscore
which may or may not cause the text on the screen to appear strange.

Why does my label print nothing but an “=” or just blank labels?
There are a couple of things that cause this error.
 The first thing is that the printer is printing as it should, but the fields it is printing are blank. If the
fields are supposed to be blank, turn the printer off.
 If you really do want labels to be printed, the most likely reason that the labels are not printing
correctly is that the printing configuration is not correct.
 Ensure that the printing is enabled in the configuration AND you have specified the label file to be
printed.

What happened to the “xxx” field in the label designer? Did you
change it? It used to be there and now it gone!


No. We did not change the field.
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The field names for the label designer are taken from your cut list definition file. If the field was
there and now it's gone, the user most likely changed the field to something else.
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